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Welcome

A Note from 
the Publisher
In my twenty years in educational technology, I have to say that
bringing Stationery Studio to market is one of the highlights of my
career. Not only do I love Dr. Peggy, her consistently amazing
work, and this software that reaches even the most reluctant
young writer – but it also brings me back to one of the defining
moments of my own childhood.

When I was in second grade my twin brother Paul and I started
our first newspaper. With the help of some ancient technology
(the Savin photocopier that my mother rescued from the trash
at work), we wrote, illustrated and shared our work with each
other, our family and school mates. We experienced first hand
the joy of creating – the joy of sharing.

Today, as a children’s book author and illustrator (The North Star,
Judy Moody, The Dot, Ish), I speak to many young children who ask
in fascination about my journey. Looking into their expectant
eyes, I tell about those early stories – and how each of them has
the power to express themselves using word and art.The key is
to begin the process – to celebrate and share the results.

My hope is that Stationery Studio will unlock the key to creative
expression for your own students – and help spark meaningful,
life-long learning journeys with each and every one of them.

All the best to you on the mission,

Peter H. Reynolds
Founder/CEO, FableVision



A Note from 
the Author
Children who learn to write well have a life-long advantage. In school,
effective writing skills are essential to academic achievement and suc-
cess on a growing battery of standardized tests. In a broader context,
communication skills allow children to connect with the world, to
share experiences, and to express feelings and opinions. Good com-
munication skills help children and adults collaborate and establish
meaningful relationships. On both a personal and global scale, commu-
nication is the key to conflict resolution and lasting peace.

If students are to become good writers, they need to write often.
Writing needs to be motivating, meaningful and satisfying. As an edu-
cator and software designer, I have observed and researched the role
of technology in this process. I’ve seen how technology motivates 
students and how children’s writing programs help them organize, edit
and publish. I’ve also seen how technological advances often disregard
the realities of the typical classroom where access to computers is
limited. Stationery Studio is different. It was designed to support class-
rooms like these where students still do most of their writing 
and test-taking by hand.

While researching this program, I talked to hundreds of teachers,
students, and parents. I discovered something surprisingly simple,
something that motivates writers of all ages – inspiring stationery!
Thousands of stationery, office and teacher stores across the country
sell a seemingly endless variety, but young writers have special needs.
They need stationery with lines geared to their developmental level
and layouts that support a variety of curriculum activities.

Stationery Studio addresses these needs. It allows teachers and 
students to choose from over 225 beautiful and imaginative 
curriculum-themed borders and shapes. And it offers what no other
program does – easy-to-use tools to customize writing lines, layout,
text and graphics, and print in multiple formats that suit your students
and your instructional objectives.

We are excited to share Stationery Studio with the world. We trust it
will inspire a flurry of writing and creativity in your classroom!

Peggy Healy Stearns, Ph.D.
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What Educators 
Are Saying
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“Stationery Studio is one of the best new products of the last two
years. Universally, my elementary teachers who are using the pro-
gram rave about it.”

— Tom Plati, Director of Libraries and Educational Technologies
Wellesley (MA) Public Schools

“Stationery Studio fits a niche in the primary classroom that has been
long ignored by educational software developers – handwriting.
There are so many options here, and they're so intuitively integrated,
that children will want to write. This program promotes student
practice in a skill that absolutely requires it. Teachers will find this is
one of those rare computer programs that actually makes their lives a
little easier.”

— Dennis G. Mike, Ph.D.,Associate Professor
Buffalo State College (NY)

“Stationery Studio is one of the most useful and versatile pieces of
software I’ve ever seen. I’ve used it in so many curricular areas that I
don't know how I managed without it!”

— Charlene Ehll, Multiage Teacher, Grades 1 and 2
Saul Mirowitz Day School-Reform Jewish Academy, St. Louis, MO

“Stationery Studio is a wonderful new tool from the creative mind of
Dr. Peggy Stearns (the creator of Graph Club and Neighborhood Map 
Machine). It will entice young children to create and write for school
and for their own pleasure using easy-to-use customizable templates.
The classroom activities are wonderful jumping off points for teach-
ers. This is a must for every early childhood and primary classroom.”

— Eileen Barnett, M.Ed.
Director and Educational Software Specialist, Lesley University
Apple Distinguished Educator and a member evaluator of the 
Educational Software Preview Guide Consortium



Stationery Studio® User’s Guide  7

“Stationery Studio is one of the most exciting software tools to come
along for elementary teachers since the computer itself!  With a few
clicks of the mouse, Stationery Studio lets you create theme-oriented
writing materials tailored to your students’ needs. It’s easy enough
for students to use on their own, yet so versatile and comprehensive
it’s also an indispensible teacher tool.

“I love the classroom activities that support each curricular area and
the playful artwork that sets the tone for creative, imaginative writing.
Thank you Dr. Peggy and FableVision for a truly wonderful, useful tool
for students and teachers.”

— Paula McGirr, M.A., Kindergarten Teacher,Williamsville, NY
Adjunct Faculty State University of New York at Buffalo

“This program is a special education teacher's dream-come-true!”

— June Cook, Exceptional Education Professional
Stuart, FL

“The beauty of Stationery Studio is that it fits into whatever you are
doing. Learning is all about communication, and Stationery Studio
provides a vehicle for children to communicate in a great variety of
ways, allowing for creativity, different styles of presentation, and lots
of fun!  FableVision has created an award-winning classic with this
great tool!”

— Evelyn J.Woldman, M. Ed., C.A.G.S.
Education Coordinator, Massachusetts Elementary School 
Principals' Assoc. (MESPA) Technology Center
Adjunct Faculty, Lesley University

“Our teachers loved Stationery Studio! It’s perfect for all sorts of 
traditional and creative learning activities and can be used in any sub-
ject area. Right away, teachers see how to put it to work in their
classrooms. No learning curve – just open and enjoy!  The graphics
are delightful and in their wonderfully enticing way, invite children to
get busy with their writing. Stationery Studio is addictive for kids 
and adults!"

— Dr. Merle Marsh,Academic Dean
Worcester Preparatory School
Berlin, Maryland
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What you need:
System Requirements

Stationery Studio is designed to run from a user’s local hard drive.

The program can be installed onto a computer from the CD-ROM or
over a Local Area Network (if your system administrator has set this up).

The program will operate on the following systems:

Windows 98, 98 Second Edition, 2000, Me, XP
Macintosh OS X Universal Binary,10.1.5,10.2.8,10.3.9 and higher
Macintosh OS-8.6 or OS-9

The computer should be set to the following:

Display:
Windows: a minimum of High Color at 800x600
Macintosh: a minimum of Thousands of Colors at 800x600

Audio:
Windows: 16-Bit Sound Blaster compatible card
Macintosh: standard audio

Refer to the Read Me file on the Stationery Studio CD-ROM for easy
installation instructions.

Visit Our Web Site!
For activities and support related to

Stationery Studio, visit the 
official web site:

www.fablevision.com/stationerystudio



Program 
Overview
What is Stationery Studio?

Stationery Studio is an innovative tool that lets students and teachers
customize and print motivating writing paper and templates for sto-
ries, letters, reports, shape books, mini-books and countless other
writing activities and creative projects. The program addresses the
needs of a typical classroom where students, even in this age of tech-
nology, do most of their writing and test-taking by hand.

Stationery Studio is easy to use. You begin by choosing one of over
225 curriculum-themed shapes and borders. Next you choose one of
five line options – primary skip-a-line, two types of basic primary
lines, standard lines, or no lines. Choose a line width between 1" and
3/8" and one of several line color options. Then use the layout tool
to adjust the location of the lined area – full page, top of page, bottom
of page, friendly letter, business letter, envelope, columns and others.

Print your stationery in color or in
black and white for students to color
by hand. Choose full page, half page,
four-per-page (for a folding mini-book),
postcard, small or large notecard.
Shapes can be printed in additional for-
mats that address a variety of instruc-
tional goals and provide the distinct
page types needed to create a polished
book project.

Use this award-winning program as an introductory word processor
with all of the basics and none of the confusion! Or create cus-
tomized stationery with appropriate writing line styles, layouts and
fonts (including dotted fonts) for students’ handwritten activities. Use
the program as a teacher tool to create activity sheets, awards, invita-
tions, letters to parents, and more.

Stationery Studio is guaranteed to nurture the creative genius in 
children of all ages. Consider the possibilities… You get over 225
designs, each of which can be customized with 5 line styles, 5 line
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widths, up to 5 line colors, and 10 layout options. You can customize
the color and add story starters or activity directions. Then print
your stationery in multiple sizes and formats in color or black and
white. In all, Stationery Studio lets you create tens of thousands of
unique pieces of stationery from one simple tool! 

Set out on a new creative adventure. Discover how Stationery Studio
can help you motivate young writers and celebrate success!

Learning Objectives

Stationery Studio supports the development of writing skills across the
curriculum by allowing teachers and students to customize and print
over 200 motivating theme-centered borders and shapes with line
style, line width, layout, writing prompts, and print formats that
address specific interests, developmental levels, and instructional goals.
The program includes 30 classroom activities, each accompanied by a
brief lesson, and 31 additional sample files, all of which provide mod-
els for a wide variety of writing activities.

Stationery Studio will support 
students as they develop skills 
in the following areas:

• Penmanship 
• Vocabulary and spelling
• Narrative writing
• Descriptive writing
• Expository writing
• Persuasive writing
• Social communications
• Journal writing
• Friendly letters
• Business letters
• Book reports
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Stationery Studio supports writing
across the curriculum with over 
60 ready-made activities correlated
with the following subject areas:

• Science
• Social studies 
• Math
• Language arts
• Health



Stationery Studio 
and the Standards
Stationery Studio supports state and national standards including 
those established by the International Reading Association (IRA), the
National Council of Teachers of English (NCTE), and the International
Society for Technology in Education (ISTE).

Handwriting: Stationery Studio promotes the development of hand-
writing ability, a key stage in writing, by allowing teachers and children
to print customized stationery with line styles,
line width and line colors that suit the writer’s
developmental level and by providing dotted
fonts for handwriting practice. By adding this
creative choice of media, Stationery Studio makes
handwriting a more attractive option for stu-
dents, thereby promoting increased practice.

Writing Process: Stationery Studio engages students in the writing
process from topic selection to publication and supports the develop-
ment of writing skills by providing customized stationery appropriate
to students’ interests, developmental level, and purpose. When used
in conjunction with the writing process, Stationery Studio is an effective
tool that can enhance the writing experience and support the follow-
ing NCTE and IRA standards:

Students adjust their use of spoken, written, and visual language
(e.g., conventions, style, vocabulary) to communicate effectively with a
variety of audiences and for different purposes. (Standard 4)

Students employ a wide range of strategies as they write and use
different writing process elements appropriately to communicate with
different audiences for a variety of purposes. (Standard 5)

Students apply knowledge of language structure, language conven-
tions (e.g., spelling and punctuation), media techniques, figurative lan-
guage, and genre to create, critique, and discuss print and non-print
texts. (Standard 6)

Students participate as knowledgeable, reflective, creative, and
critical members of a variety of literacy communities. (Standard 11)
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Students use spoken, written, and visual language to accomplish
their own purposes (e.g., for learning, enjoyment, persuasion, and the
exchange of information). (Standard 12)

National Educational Technology Standards: Stationery Studio
supports the following standards established by the International
Society for Technology in Education:

Students demonstrate a sound understanding of the nature and
operation of technology systems. (Standard 1)

Students are proficient in the use of technology. (Standard 1)

Students develop positive attitudes toward technology uses that
support lifelong learning, collaboration, personal pursuits, and produc-
tivity. (Standard 2)

Students use technology tools to enhance learning, increase pro-
ductivity, and promote creativity. (Standard 3)

Students use productivity tools to collaborate in constructing
technology-enhanced models, prepare publications, and produce other
creative works. (Standard 3)

Students use a variety of media and formats to communicate
information and ideas effectively to multiple audiences. (Standard 4)

*  * *  *  *

Stationery Studio and the Standards, continued
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How to Use
Stationery Studio 
Quick Start!

1. Start New Stationery: From your desktop, double-click
the Stationery Studio icon. When the title screen appears, click Start,
then choose New Stationery.

2. Choose a Design: Click to choose a theme, or click Search
and enter a keyword. In Choose A Design, click the name of a
design to preview it. If you want, use the buttons at the top to view
Borders Only, Shapes Only, Envelope Sets, or Borders,
Shapes and Envelopes. To choose a selected design, click Go.

3. Edit Design:
Click the tools
along the left to see
options for lines,
layout, text and
color displayed
across the top.
Experiment and dis-
cover all the ways
you can customize
your stationery!

4. Print: Click
Print to go to
Print Preview.
Select different print
options to see how
your design will
look.

Click Print to go to
your computer’s
print dialog and
print your design.

It’s that easy!
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Customize and
Print Stationery in

4 Easy Steps! 



Stationery Studio
Walkthrough
This walkthrough describes all Stationery Studio’s tools and features.
Brew a cup of your favorite tea, pull up a chair, and let us guide you
step by step. Or if you prefer, choose Tour from the program’s Main
Choice Screen, then sit back and watch our animated tutorial.

New Stationery

Choose
Your
Stationery

On the title screen,
click Start to go to
the Main Choice
Screen, then click
New Stationery.

Stationery Studio
includes over 225
shapes and borders
correlated with the
curriculum. Click to
choose a theme, or
click View All to
browse the entire
collection. For our
walkthrough, let’s
look at Animals &
Insects.
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The Choose A Design Screen lists all the designs that match your
theme. Click the name of a design to see it in the preview window.
To go to a specific design, press the first letter or letters of the name
to go directly to
that part of the list.

The buttons at the
top let you choose
what kinds of
designs you want
to see. Borders,
Shapes  & Envelopes
are selected. If you
want, click Borders
Only,Shapes Only,
or Envelope Sets.

To find all the designs related to a 
specific topic, click Search.

You can select any of the 50 suggest-
ed keywords or enter your own.
Let’s choose “Autumn” and click 
Go to see the designs for that topic.
When you get to the Choose A
Design Screen, you’ll see “Leaves” 
as one of your choices. Select that
design and click Go to move on to the Edit Screen.

Customize Your Stationery
Edit Design lets
you customize
lines, layout and
color. You can also
use the basic text
tool to add story
starters, directions
or other text.

When the Edit
Screen opens, the
Lines options are
already available.
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Layout choices for vertical borders are full page, top of page, bottom
of page, two columns, left column, right column, friendly letter, busi-
ness letter, and envelope. The Set Margins Tool at the far right lets
you adjust the margins. Click the tool, then drag the red margins to
reset them.

Note: Friendly letter, business letter, and envelope are available for
one-page documents only and work best with narrower line widths.

Layout choices for horizontal borders are full page, top of page, bot-
tom of page, two columns, left column, and right column. Use the
Set Margins Tool at the far right to adjust the margins.
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The Lines Tool lets you choose line style, line width
and line color. Line color choices vary depending on
the selected line style. Click to select options.

Line Style Line Width Line Color

Click the Layout Tool to choose a layout.

Layout choices vary depending on whether you have
a vertical border, horizontal border, or shape as
noted below.

Layout Choices for Vertical Borders

Layout Choices for Horizontal Borders

The Lines Tool

The Layout Tool

 



Layout choices for shapes are full page, top of page, bottom of page.
Use the Set Margins Tool to adjust the margins.

Stationery Studio includes basic text editing features. Click to place
your cursor in the text area and start typing. As soon as you type,
the New Page Button appears. Click this button to create a new
page at the end of your document.

You can also use any fonts installed in your system by going to the
Font Menu. You can hide the Font Menu by checking this option
in Preferences.

Click to choose a font size. Line width changes to match. You can
also click to choose alignment. Change font color by placing your
mouse over the color swatch at the right end of the toolbar and
clicking a color in the pop-up palette.

To force a page break in the middle of your text, go to the Edit
Menu and choose Insert Page Break. Stationery Studio lets you
create documents up to 28 pages long.
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Layout Choices for Shapes

Click the Text Tool to choose another font, font
size, or font color.

In the Text Toolbar, click to choose one of Stationery
Studio’s eight fonts, which include print, manuscript,
cursive, dotted versions of each, and two playful fonts.

Fonts                         Sizes     Alignment   Color

The Text Tool

Tip: For younger users, you can limit documents to one page
only. Go to the Edit Menu and choose Preferences. Then
check “Limit Stationery to a single page”. (This option is not avail-
able when a multi-page document is already open.)

 



Click a color in the paint palette, then position the paint bucket over
the area you want to color and click again. When you color one
area, related areas are painted the same color.

If you want to color from scratch, click Erase Colors. Click
Restore Original to return to the original colors.

Paste graphics. You can modify any Stationery Studio design by
adding your own photos, clip art, school logo, or drawings. You can
even start with a blank page and paste in your own border or shape.
Simply copy your graphic from within any program, paste it into your
Stationery Studio file and drag to place. While the graphic is selected,
you can grab the corners and drag them to resize it. Note: see the
FAQ section for Windows users.

If you place your graphic in a lined area, the lines and any typed text
will print on top of your image. Use the Set Margins Tool in the
Layout Toolbar to define a text area that suits your graphic. Your
pasted graphic becomes part of the stationery design and will appear
on every page.
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Color. Click the Color Button to color
your shape or border.

Black & White. Click the Black & White Button
to change the entire design, including writing guide-
lines, to black and white line art. This option is
useful if you plan to make photocopies or want
children to color by hand.

Special Feature: If you want to print your design in black and
white for kids to color by hand, but want the writing guidelines in
color, click the Color Button, and then click Erase Color. The
writing guidelines will still print in color as long as you select color
when you print.

The Color Tool

Tip: Try using a lightened or dimmed image to create a watermark.

 



Save Your Stationery
Click Save in the lower right corner.

Navigate to the disk and folder where you want to save your file.

In the dialog box, type a name for your stationery and click Save or
press Return.

Stationery Studio files can also be saved as “templates” which open as
“Untitled” so changes are not saved over the original. Use this 
feature to create your own activity files. To save as a template, go to
the File Menu and choose Save as Template.

You can export your Stationery Studio file as a graphic in any of eleven
formats. Go to the File Menu and choose Export as Graphic. Then
choose a file format in the lower left corner of the Save dialog box.

Print Your Stationery

To go to Print Preview, click the Print Button in the lower right 
corner of the Edit Screen. Print options vary depending on the type
of design and the number of pages.

Click to choose one of the print options on the left — Full Page,
2-per-page, 4-per-page, Postcard, Large Notecard, or Small
Notecard.

4-per-page is printed so the pages form a small book when folded.
If you select Small Notecard, you can choose to have standard lines
printed inside where students write their message.
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Print Options for Borders

 



Note: For friendly letter, business letter and envelope, only the 
full-page layout is available, so other options will not appear.

For Shapes, three additional options appear on the right — Shape
with Layout, Shape Only, or Mirror Image. After you choose
one of the options on the left, experiment with the different print
formats on the right. (See the related book Let’s Get Writing! for ideas
on how to use these different formats in the classroom.)

Print Options for Shapes

Click a crayon icon in the lower right to choose Color or Black &
White (line art only). If you plan to make photocopies, you’ll proba-
bly want to print in black and white.

Click Print to go to your system print dialog, then watch your cus-
tom stationery appear!

Return to the Main Choice Screen

If you don’t want to print now, click Cancel to return to the Edit
Screen. From the Edit Screen, click Done in the lower left corner to
return to the Main Choice Screen. If you have not saved your sta-
tionery, you will be prompted to do so.

*  * *  * *
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Classroom Activities
Stationery Studio includes 30 classroom activities that support your
teaching objectives across the curriculum. Each activity includes one
or more ready-made files along with brief activity instructions that
outline goals, overview, materials, step-by-step directions, and exten-
sions. You can print these ready-made stationery files or customize
them to suit your students’ needs. These activities can also serve as
models for your own original designs.

From the Main Choice Screen, click Classroom Activities. Then
click to choose a subject area.

From the list of activities, click the name of a file to see a preview.
Click Open or Choose to open.

When the file is open, click the Activity Instructions Button in the
Edit Screen to open the lesson. You can read the lesson on screen 
or print it. When you’re finished, close the lesson window or quit
Adobe Acrobat or other PDF Reader to go back to Stationery Studio.
(Activity instructions are in PDF format. Adobe Acrobat Reader is
included with Stationery Studio so you can open these lesson files.)

PASSWORD: When you select or deselect password protection, you
must enter the password. The password is “admit”.
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Tip: To prevent students from opening Acrobat Reader, go to the
Edit Menu and choose Preferences. Then check “Password-
protect Activity Instructions and User’s Guide”.

 



Sample Projects 
Sample Projects includes a variety of Stationery Studio files includ-
ing stories, poems, letters, shape books, journals, postcards, note
cards, message pads, certificates, gift tags and more. From the Main
Choice Screen, click Sample Projects.

In the Open Dialog, click the name of a file to see a preview. Click
Open or Choose to open the file. Sample stationery files can be
printed as is or modified.

Tour
The animated Stationery Studio Tour is a quick, easy and fun way to
learn the ins and outs of Stationery Studio. Click the Tour Button
on the Main Choice Screen or choose Tour from the Help Menu.
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Photo Gallery
The Photo Gallery features photographs of completed Stationery
Studio projects including shape books, mini-books and standard
books, activity sheets, journals, stories, reports, address books, note
cards, postcards, message pads, gift coupons, gift tags, recipe cards,
stuffed pillows and more. Click Photo Gallery from the Main
Choice Screen or go to the Help Menu and choose Photo
Gallery. Then click a name in the list to view that photo.

Open My Projects
To open your own saved stationery projects, click Open My Projects
from the Main Choice Screen, or go to the File Menu and
choose Open. When the dialog box appears, navigate to the correct
disk and folder.

Click file names to see previews of your stationery. When you see
the file you want, click Open or Choose to open the file.
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Features & Functions

File Menu
New: Lets you choose and customize
new stationery.

Open: Lets you open previously saved
stationery.

Close: Closes the current stationery file.

Save: Saves the current stationery file.

Save as: Lets you save a previously saved
file under a different name or location.

Save as Template: Lets you save your file as a template that opens
as an untitled document.

Export as Graphic: Lets you export the stationery in any of eleven
formats including BMP, JPEG, PICT, QuickTime™, and TIFF.

Page Setup: Lets you choose page size and other standard print
options. However, since Stationery Studio automatically chooses opti-
mal page setup options and will override page orientation, there is 
little need to use the Page Setup Dialog.

Print: Opens the Print Preview Screen so you can choose print
options and proceed to your computer’s print dialog.

Quit (or Exit for Windows): Closes the program and prompts
you, if necessary, to save the current stationery file. (In Mac OS X,
Quit is located in the Stationery Studio menu..

Edit Menu
Undo: Lets you undo your last action.

Cut: Lets you cut the selected text or
pasted graphic so you can paste it in
another location. (Available in the Edit
Screen when any text or pasted graphic
is selected.)

Copy: Lets you copy the selected text or
pasted graphic so you can paste a copy in another location. (Available
in the Edit Screen when any text or pasted graphic is selected.)
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Paste: Lets you paste the contents of your clipboard into your 
document.

Delete: Removes the selected item. (Available in the Edit Screen
when any text or pasted graphic is selected.)

Select All: When there is text and the cursor is flashing, selects all
text so you can cut, copy or delete.

Insert Page Break: Inserts a page break after the cursor. If you are
at the end of the document, Insert Page Break adds a new page.
This command is not available for letters and envelopes because they
are limited to one page.

Preferences: Lets you customize the program to meet the needs of
your students. (In Mac OS X, Preferences are located in the
Stationery Studio menu.)

Font Menu 
Lets you choose any font installed on your computer and use it in
your Stationery Studio file.
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PASSWORD PROTECTION:
When you select or deselect password protection, you must 

enter the password. The password is “admit”.



Help Menu
Stationery Studio Web Site: Connects you to the Stationery Studio
web site to explore Stationery Studio resources or other FableVision
products and services. Available when you have an internet connection.

User’s Guide: Opens the User’s Guide in Adobe Acrobat or other
PDF Reader.

Tour: Opens the Stationery Studio Tour.

Photo Gallery: Opens the Photo Gallery so you can view photos
of Stationery Studio projects.

Main Choice Screen
The Main Choice Screen includes the following options:

New Stationery: Lets you select and customize new stationery.

Open My Projects: Lets you open your own saved stationery files.

Classroom Activities: Lets you open and print Stationery Studio
files and related lessons.

Sample Projects: Lets you open and print additional sample
Stationery Studio files.

Tour: Opens the Stationery Studio Tour, which provides an animated
walkthrough in four short segments.

Photo Gallery: Opens the Photo Gallery so you can view photos
of completed Stationery Studio projects.

Quit: Quits the program.

Edit Design Screen
The following tools and options are available in the Edit Design Screen:

Lines: Lets you choose line style, line width and line color.

Layout: Lets you choose from up to nine different layouts and adjust
margins.

Text: Lets you choose font, font size, alignment, and font color.

Color/Black & White: Lets you custom color the design or choose
black and white line art.
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Tips & 
Techniques
Here are a few tips and techniques to help you take full advantage of
Stationery Studio and create really cool projects.

Go to the Fonts Menu to use your own favorite fonts in your
Stationery Studio projects.

Use the Set Margins Tool to change the margins. Your current 
layout will be reformatted to fit. All new layouts will “pour” into
these margins.

Use the Set Margins Tool with shapes when
you want a rectangular writing area rather than the
free-form text area that conforms to the shape.

Paste your own graphics into any border or shape.

Ordinarily pasted graphics are opaque and cover underlying 
graphics. If you want overlapping graphics to blend together, go to
Preferences and check Blend Pasted Graphics. Experiment with 
different effects! 

Create fold-over notes by printing the friendly letter format on
one side of your paper and the envelope format on the other.

Keep small printouts readable. When you use the 4-per-page print
option, choose larger fonts and wider line widths since everything will
be reduced to about 25% of the original size.

Create stationery to use with your other favorite software. Print
your favorite Stationery Studio borders or shapes without lines, then
use the stationery when printing with any word processor, desktop
publisher or other program.

Be creative. Stationery Studio is an easy way to create awards,
message pads, gift tags, gift coupons, postcards, book labels, and much
more. Check out the Photo Gallery, Sample Projects and
Classroom Activities, then out-do us!  Stretch your imagination
and exploit the program. Visit the Stationery Studio web site for more
great ideas: www.fablevision.com/stationerystudio.
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Frequently Asked Questions
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Does Stationery Studio run natively in OSX?
Yes, it does run natively in OSX. There are 2 separate Mac Installers, one for
OSX, and one for OS 8.6-9.2.

Can I export a template as a graphic?
This function doesn't work if you're using Windows platform.

What is the password and/or serial number to install the program?
Stationery Studio doesn't require a password or serial number to be installed, so
if your computer asks for one, this might come from the way your computer is
set up. One of the possible reasons is that you need an administrative machine
log-in in order to install any new application. Contact your Technology
Coordinator about that or even leave the password field blank and it might work.

Can I print on a network printer?
The driver for each printer used needs to be loaded onto the computer itself.
After you install the correct driver for the correct printer, restart your computer
and test to see if it works.
This is valid for different kind of printing issues like:
• Template not printing at all
• Some part of Stationery Studio page does not print or does not print correctly,
i.e lines, dashes, graphics etc
• The Stationery Studio document does not fit correctly on an 8 1/2 x 11 page.

Why do I have a black image printed instead of the Shapes?
If you are using the Windows platform, on each computer that is printing a black
image instead of a shape use this key combination:
Hit CTRL and the number 3 (not F3), and you will get a dialog box. Check off
'always print as bitmap' on the options available.

How do I paste photos/clipart on a PC?
When using the Windows platform, integrating pictures takes one more step than
the one described in page 18.
Copy the image and paste first into MICROSOFT WORD, then copy it (from the
Word document) and paste it into Stationery Studio.
Also, Stationery Studio does not support images of more than 256 colors. So the
resolution of photographs integrated in a Stationery Studio document may be
pixellated but it works perfectly fine with ClipArt or other simple drawings.

Why are the dashed/broken lines printing Solid?
If using the Windows platfom, hit CTRL and the number 3 (not F3), and you will
get a dialog box. Check off 'always print as bitmap' on the options available.

Why do I get a memory error when pasting an image on a PC?
If you are using Windows, a memory issue usually means that your graphic is too
large of a file. You should try and reduce it in another program before
copying/pasting.

How do I fix a shaky projection on MAC G4?
Change the resolution from 800 x 600 to 1024 x 768.

 


